
Welcome !

“Manipulating Big(ish) Data in Excel, 
and Reading into R”

Fred Wright – North Carolina State University
Candice Brinkmeyer-Langford – Texas A&M University

Dillon Lloyd – North Carolina State University

This Session will Begin at 2:00 pm Eastern US Time



• All participants are muted to enable the speaker to present without interruption.

• Please rename yourself and designate Full Name and Affiliation.

• Last-minute installation issues? Use private chat to Dillon Lloyd.

• Use the reaction icon at the bottom of your screen to raise your hand.

However, due to time constraints, most questions will be answered in 

chat window, with answers posted later as an FAQ.

• This meeting will be recorded, and posted on the @tamusuperfund website  

https://superfund.tamu.edu/big-data-series-2021/ in the coming weeks.

https://superfund.tamu.edu/big-data-series-2021/


Basics Managing data 
and plotting

Data analysis
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What is this session about?
• This session is NOT a comprehensive introduction to Excel

• We present a number of topics that have been useful to the speakers 
for Superfund-relevant data.

• In other words, what do we and collaborators do most often?

• We include links to a number of topics

• We assume only the most basic familiarity with Excel
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What is this session about?
• Excel is not the main tool for data science

• It is a widely used tool for storing and working with data

• Best practices need to acknowledge reality that Excel is widely used
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Basics

Fred Wright, NC State University
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What is Big Data?

• Big Data invokes and 
evokes a lot of concepts

• Data we can hold in one 
spreadsheet is not that big

• However, data that we 
cannot perceive in one 
screenful is big enough 
that we need to let the 
software tell us things

Josh Lee, Medium Soundcloud

Amazon

7



Excel data limits

• Much better than the old 
days!

• Roughly speaking, big 
enough for gene expression 
datasets

• Not big enough for genome 
scans or sequence data
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PC vs. Mac

CTRL*  vs.  CMD*
* means whatever you are typing!

Tab
Ribbon (may need to turn on the ribbon using View)
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Got an Excel question?

• The search bar is pretty good!

• If you’re still not sure, try 
googling the question, which 
often leads to a keyword

• Examples 
- format values in Euro currency
- how do I turn my rows into 
columns…. what is that called?
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Importing data from a text file

• Use file>open>browse>(correct format)>open

• But… this is not an Excel file

• The text import wizard saves the day. Pay attention to delimiters 
(character that separates variables)

• Need to skip the first few lines? There’s a box for that! 

https://support.microsoft.com/en-us/office/import-or-export-text-txt-or-csv-files-5250ac4c-663c-47ce-937b-
339e391393ba
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I goofed!

• Never fear, CTRL-z is here

• or undo curvy arrow

• Wait, I didn’t goof! 

Other curvy arrow (or CTRL-y)

https://support.microsoft.com/en-us/office/undo-redo-or-repeat-an-action-84bdb9bc-4e23-4f06-ba78-
f7b893eb2d28#:~:text=To%20undo%20an%20action%20press,want%20to%20undo%20multiple%20steps.

lowes.com
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Jump around

• You can scroll around

• Or you can jump using CTRL* (e.g. CTRL )

• Try CTRL END or CTRL HOME. What do they do?

• These are called “shortcuts”

• Select stuff using SHIFT

• Combine stuff, e.g. CTRL SHIFT *

https://support.microsoft.com/en-us/office/move-or-scroll-through-a-worksheet-06fc34b8-64bb-
4d78-9b62-34656d700f82

hot147.com
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Freeze panes!

• Useful for scrolling around while keeping some 

rows/columns fixed

• View>freeze panes >freeze panes

• Top row, first column, and what else?

EMI

Deen

Pixar

DMITRY LOVETSKY/AP

EMI and Georgann Deen
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Appearance and formatting of cells (basic)

• Cell appearance similar to other MS products

• Boldface, italics, text, size, etc.

• Formatting may appear on the Home action bar

• Or Design>formatting

• Check Alignment and Number

• The formatting doesn’t really change the underlying values (look at 
formula bar)

https://support.microsoft.com/en-us/office/available-number-formats-in-excel-0afe8f52-97db-41f1-b972-
4b46e9f1e8d2
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Sorting

• select value in a column, hope for the best!

OR

• do it deliberately, Home>Editing>Sort and Filter>Custom Sort

• But I have two header rows!

• Sorting is dangerous! Always do a sanity check. Did I sort the region 
intended, and not just one column?

https://support.microsoft.com/en-us/office/sort-data-in-a-range-or-table-62d0b95d-2a90-4610-a6ae-
2e545c4a4654
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Adding, deleting, hiding

• Logical for the most part

• The right mouse button is your friend 

https://support.microsoft.com/en-us/office/insert-or-delete-rows-and-columns-6f40e6e4-85af-45e0-b39d-
65dd504a3246#:~:text=To%20insert%20a%20single%20column,and%20then%20select%20Insert%20Column
s.
https://support.microsoft.com/en-us/office/hide-or-show-rows-or-columns-659c2cad-802e-44ee-a614-
dde8443579f8
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Highlighting info by conditional formatting

• Highlight interesting cells or ranges of cells

• Select cells

• Home>Conditional formatting

• Take a look and explore

https://support.microsoft.com/en-us/office/use-conditional-formatting-to-highlight-information-fed60dfa-1d3f-4e13-
9ecb-f1951ff89d7f
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https://support.microsoft.com/en-us/office/use-conditional-formatting-to-highlight-information-fed60dfa-1d3f-4e13-9ecb-f1951ff89d7f


Simple functions and formulas

• Make new columns that are log10 of the previous columns

• Note how the cells are relative in the formula

• You can change them to absolute (sometimes called “anchor”) values 
by using $ or F4 (on PC)
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Transforming data (Power Query)

• Data tab

• From table/range (make sure correct range is 

selected)
wayfair.com

https://www.youtube.com/watch?v=yE8sLnywPAg
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Drop-down lists

1. Select the cells that you want to contain the lists.

2. On the ribbon, DATA -> Data Tools->Data Validation.

3. Allow to List.

4. Click in Source, type the text or numbers (separated by 
commas, for a comma-delimited list) that you want in your drop-
down list, and click OK.

https://support.microsoft.com/en-us/office/create-a-drop-down-list-7693307a-59ef-400a-b769-c5402dce407b
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Good naming and formatting practices for sharing data 
via spreadsheet

• Data science is 1% inspiration, 99% exasperation (mainly caused by extra 
spaces, poor heading labels, and unnecessary detail in missing  data)

concept reality
cambiasorisso.com

martech.org
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• DO keep all the data as one row/column rectangle (if possible)

• DO keep things as simple as possible

• DO keep column headings descriptive and CONSISTENT, including utterly 
consistent capitalization

• DO use a single code (e.g. NA) for missing data if possible

• DO NOT merge cells

• DO NOT add actual commas to numerical values

• DO NOT add hidden spaces in data

• DO NOT use spaces in column headings. Underscore is preferred.
Ainsley Seago. doi:10.1371/journal.pbio.1001779.g001
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Good naming and formatting practices for sharing data 
via spreadsheet

https://doi.org/10.1371/journal.pbio.1001779.g001


Transposing data

• Changes rows to columns

• Not exactly “turning the rectangle of data on its side”

• Copy and Paste Special, select Transpose

• See https://support.microsoft.com/en-us/office/transpose-function-
ed039415-ed8a-4a81-93e9-4b6dfac76027 to learn how to do this 
using the TRANSPOSE function, while preserving formulas
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Create tables

• Don’t we already have a table?’

• A table is a specific object for a rectangular data range that Excel can 
use for analysis

• Hallmark of a table is the coloring/banding, and the drop down
button for column headings

• Home > Format as Table

https://support.microsoft.com/en-us/office/create-and-format-tables-e81aa349-b006-4f8a-9806-5af9df0ac664
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Pivot tables

• Useful for summarizing totals, etc. across variables

• Similar to cross-tabulation

• Somewhat restricted to certain functions, etc.

• Insert>Pivot Table

• The next speaker will provide different ways of summarizing what you 
have

https://support.microsoft.com/en-us/office/create-a-pivottable-to-analyze-worksheet-data-a9a84538-bfe9-40a9-a8e9-
f99134456576
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Next up: Manipulating data and counting 
stuff! 

http://publicdomainaudiovideo.blogspot.com/

27



Manipulating Big(ish) Data in 
Excel

Candice Brinkmeyer-Langford

Texas A&M University
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Excel version and support

• Excel version being used: 
Microsoft Excel for Mac, version 
16.51

• https://support.microsoft.com/e
n-us/office/excel-video-training-
9bc05390-e94c-46af-a5b3-
d7c22f6990bb
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Answering questions with Excel
IF
COUNTIF
AVERAGEIF
LOOKUP
VLOOKUP 

Charts:
Bar chart
Scatterplot
Secondary axis
Stacked bar chart
Box-and-whisker plot

Miscellaneous tips and tricks
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IF

• I want to know if individual 8 is female.
• I could just look at this little table, obviously, but pretend it’s a much bigger 

dataset.

• The IF function can have 2 results (True or False)

• =IF(test,value_if_true,value_if_false)
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IF

• We are looking on a different 
sheet for our answer, hence the 
sample_values! before the 
specific cell I2

• Because we want to know if the 
contents of cell I2 are a specific 
value, we use quotation marks: 
“F”

• Don’t forget to add the comma!

32



IF

• If my test is true – that is, if column I2 is “F” (in other words, 
individual #8 is female…
• “YES”,

• If it’s not true, I want Excel to say “NO”

• Don’t forget to close the parentheses so Excel knows you’re done.
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IF
• When I add the close parenthesis (“)”) and hit Enter, I can go back to 

my original sheet (Sheet1, in this case) and see my answer.
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How many are in certain categories…?

COUNTIF function counts how many 
cells in a given range have a certain 
value

=COUNTIF(Where do you want to 
look?, What do you want to look for?)
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How many are in certain categories…?

COUNTIF function counts how many cells in a 
given range have a certain value

=COUNTIF
(the equals sign tells Excel you want it to carry out 
some function)

Then, open parenthesis to tell Excel exactly what 
you want it to search (“cells in a given range”) and 
what you want it to search for (“a certain value”)
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How many females are in this data set?

COUNTIF function counts how many cells in a given
range have a certain value

Where is the “range” of data that contains what 
we want to count?

Here, the “range” is on a different sheet 
(sample_values). This is OK.

The exclamation point (!) tells Excel to look on a 
different sheet: sample_values!
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How many females are in this data set?
We want to count the number of 
females. 

Range here is the second row of the 
sheet sample_values:

B2:U2 (cells B2 through U2)
or 2:2 (select entire row)

The colon (:) means “through”
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How many females are in this data set?

COUNTIF function counts how many cells in a given
range have a certain value

The value we want to count is number of females.

After we specify the range, add a comma (,) and then 
the value we want to count.

“F”
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How many females are in this data set?

COUNTIF function counts how many 
cells in a given range have a certain 
value

Another option: after we specify the 
range, add a comma (,) and then a 
cell containing the value we want to 
count.

sample_values!C2
(“C2” will tell Excel to count cells containing 
C2 rather than the contents of cell C2) 40



QUESTION 1…

• Which formula should I use if I want to know how many individuals were exposed (status is Y)?

A: =COUNTIF(B3:U3,”Y”)

B: =COUNTIF(sample_valuesB3:U3,Y)

C: COUNTIF(sample_values!B3:U3,”Y”)

D: =COUNTIF(sample_values!B3:U3,C3)

E: =COUNTIF(sample_values!B3:U3,”Y”)
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How to count how many were exposed
A: =COUNTIF(B3:U3,”Y”)  did not specify the correct 
sheet where the data was located

B: =COUNTIF(sample_valuesB3:U3,Y)
C: COUNTIF(sample_values!B3:U3,”Y”)
D: =COUNTIF(sample_values!B3:U3,C3)
E: =COUNTIF(sample_values!B3:U3,”Y”)
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How to count how many were exposed
A: =COUNTIF(B3:U3,”Y”)

B: =COUNTIF(sample_valuesB3:U3,Y)  there is no 
exclamation mark after the sheet name

C: COUNTIF(sample_values!B3:U3,”Y”)
D: =COUNTIF(sample_values!B3:U3,C3)
E: =COUNTIF(sample_values!B3:U3,”Y”)
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How to count how many were exposed
A: =COUNTIF(B3:U3,”Y”)
B: =COUNTIF(sample_valuesB3:U3,Y)

C: COUNTIF(sample_values!B3:U3,”Y”)  there is no 
equals sign before COUNTIF

D: =COUNTIF(sample_values!B3:U3,C3)
E: =COUNTIF(sample_values!B3:U3,”Y”)
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How to count how many were exposed
A: =COUNTIF(B3:U3,”Y”)
B: =COUNTIF(sample_valuesB3:U3,Y)
C: COUNTIF(sample_values!B3:U3,”Y”)

D: =COUNTIF(sample_values!B3:U3,C3) → The value for 
cell C3 will be searched for based on whatever sheet 
you’re on, rather than the sheet with the data

E: =COUNTIF(sample_values!B3:U3,”Y”)
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How to count how many were exposed
A: =COUNTIF(B3:U3,”Y”)
B: =COUNTIF(sample_valuesB3:U3,Y)
C: COUNTIF(sample_values!B3:U3,”Y”)
D: =COUNTIF(sample_values!B3:U3,C3)
E: =COUNTIF(sample_values!B3:U3,”Y”)  correct!
This will count how many individuals have “Y” in the 
Status row.
Could also search for the value in cell C3 of the 
sample_values sheet, which is also Y.
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What if I want to know how many females were 
exposed?

• You can “nest” multiple COUNTIF functions by using COUNTIFS

You still need to follow the same basic procedures as before.

49



How many females were exposed?

• You can “nest” multiple COUNTIF functions by using COUNTIFS

Criteria_range1 
= where to look 
(first criteria)

Criteria1
= what to look for 
(first criteria

50



How many females were exposed?

(Criteria range1 = where to look, Criteria1 = what to look for, Criteria range2 = where to look, Criteria2 = what to look for)
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How many females were exposed?

• Our answer, found using COUNTIFS!
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What if I want to know the average Cat1 value 
for all females that were exposed?
• AVERAGEIF: averages cells that meet one criteria
• AVERAGEIFS: averages cells that meet multiple criteria
• =AVERAGEIFS(range you want to average, first range of 

interest, what to look for in first range, second range of 
interest, what to look for in the second range….)
• Range we want to average: Cat1
• First range of interest: sex

• Look for “F”
• Second range of interest: exposure status

• Look for “Y”
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What if I want to know the average Cat1 value 
for all females that were exposed?

On Sheet1, add a 
place for 
AVERAGEIFS
calculation…
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What if I want to know the average Cat1 value 
for all females that were exposed?

Cat1 values are in the 
sample_values sheet, row 
4.

We are telling Excel, “The 
numbers I want averaged 
are located here.”
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What if I want to know the average Cat1 value 
for all females that were exposed?

Values for Sex
are in the 
sample_values
sheet, row 2.

We are telling 
Excel, “When you 
calculate the 
average, only 
include values 
from females.”56



What if I want to know the average Cat1 value 
for all females that were exposed?

Exposure 
status values 
are in the 
sample_values
sheet, row 3.

We are telling 
Excel, “When 
you calculate 
the average, 
only include 
values for 
exposed 
individuals.”57



We have an 
answer!
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TRUE or FALSE:

Understanding the effect of exposure on average Cat1 
values for females could involve an AVERAGEIFS 

calculation for unexposed (control) females.
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Let’s see…

• Start out the same as before:
• We still want average Cat1 values =AVERAGEIFS(sample_values!B4:U4,

• We still want data for females sample_values!B2:U2, “F”,
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Let’s see…

• Now we have calculated the average value of Cat1 for females that 
were NOT exposed. sample_values!B3:U3, “N”)
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Difference between exposed 
and unexposed (control)
• Calculate the difference by subtraction.

• This isn’t a formula, so no parentheses
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TRUE!

• If we want to see how exposure affects the average Cat1 values for 
females, we could start by doing an AVERAGEIFS calculation for 
unexposed females.

Cat1 average value is higher
in exposed females versus 
unexposed females.
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How to find a specific value

• LOOKUP function
• When you want to search a specific row or column for some 

value that corresponds to another row or column

• =LOOKUP(
• the specific thing you already know [“lookup_value”],
• the row/column that contains the information you already 

know [“lookup_vector”],
• the row/column that contains the value you’re interested in 

[“results_vector”])
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What is the Cat7 value for individual 8?

=LOOKUP(the specific thing you already know [“lookup_value”], the row/column that 
contains the information you already know [“lookup_vector”], the row/column that contains 
some value that information corresponds to [“results_vector”])

• The lookup_value here is ID number 8

• The lookup_vector here is the row with all the ID numbers
• IMPORTANT: Lookup_vector must be in ascending order. (Ours is already ordered numerically, 

left to right.)

• The results_vector here is the row with all the Cat7 measurement values. 67



What is the Cat7 value for individual 8?
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What is the Cat7 value for individual 8?
Lookup value: individual 8

Lookup value = 8

I could also select cell containing the 
sample ID for individual 8. 
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What is the Cat7 value for individual 8?
Lookup vector: all the sample IDs

I select the entire Sample ID row for sheet sample_values by clicking on the row number 1.
(If my data were in columns, I could click the column letter to select the entire column.)
This also tells Excel what sheet to look at.
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What is the Cat7 value for individual 8?
Result vector: all the Cat7 values

I select the entire Cat7 row by clicking on the row number 10 in the sheet sample_values.
(Again, if my data were in columns, I could click the column letter to select the entire column.)

71



We got the correct answer!
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When to use LOOKUP

• LOOKUP can be very useful when you have a large dataset to 
search.

• LOOKUP is used when the value you want to match is in the 
first row/column.

• If your lookup_vector isn’t in ascending order, it is possible 
you will get a result... But it may not be the correct result!
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Ordering data: columns
• Make sure your 

lookup_vector data is in 
ascending order by SORTING 
the lookup_vector
row/column before you try 
to use LOOKUP.

• Data → Sort → choose 
which column you want to 
sort, and how you want it 
sorted (e.g. ascending order 
[A to Z], descending order [Z 
to A], etc.)
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Ordering data: rows

• If you need to sort a row 
instead of a column, click 
“Options…” and select “Sort 
left to right”
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VLOOKUP

• =VLOOKUP(lookup_value,table_array,col_index_num,[range_lookup])

• =VLOOKUP(
• Lookup_value, What you want to look up

• Table_array, Where you want to look for it

• Col_index_num, The column number in the range containing the value to return

• Range_lookup) Return an Approximate (TRUE) or Exact (FALSE) match
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VLOOKUP
• VLOOKUP doesn’t require anything be sorted 

by ascending order!

• BUT, the value you look up needs to be to the 
left of the return value you want to find.

• XLOOKUP can look in any direction, but it’s 
not available on all versions of Excel.

• INDEX and MATCH, used independently or 
nested, may be superior to VLOOKUP for 
some circumstances.
• https://exceljet.net/index-and-match
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VLOOKUP: What is the Cat7 value for 
individual 8?
• Repeating the search we did 

before, but this time 
pretending nothing is in 
order
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VLOOKUP

• We want to know the Cat7 value… 
so that’s my lookup_value
• Don’t highlight the whole 

row/column, just select the category 
name
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VLOOKUP

The table_array can be the entire 
table, or whatever section you 
want to search. 
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VLOOKUP

• Individual #8, the one I’m 
interested in, is 9 columns to the 
right of my lookup_value (Cat7).

• So here, 9 is my col_index_num
1       2      3      4      5      6      7      8      9

82



VLOOKUP
• Now I put FALSE (or 0) 

because I want an exact
match.

• If I’d put TRUE, or 1, I might 
get an approximate match.
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VLOOKUP

(For fun, I tried putting “TRUE” and I got the same result in this 
situation.)
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Nested VLOOKUP

• What if I want to know whether a certain result could be found for a 
certain individual?
• Here: is the value “10” found for “Brinkmeyer-Langford”?

• We can nest the VLOOKUP function inside another function, in this 
example an IF.
• We just want a true/false answer here, so we start with the IF function.

NOTE: Excel can also count or 
look for values that are 
greater or less than 
something, using “<“ and “>”.85



Nested VLOOKUP

1 2

VLOOKUP to determine the value in the 
Num_letters column corresponding to 
”Brinkmeyer-Langford”

Lookup_value: “Brinkmeyer-Langford” or A6
Lookup_vector: whole table
Col_index_num: 2
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Nested VLOOKUP

TIP: KEEP AN EYE ON THE PARENTHESES!
The VLOOKUP part is all together, within the IF part. Excel color-codes them for you automatically.
Excel sees you want to do an IF (true/false) test, but will first complete the VLOOKUP part, then use the result value it gets 
to finish working out the IF part. If parentheses aren’t in the proper place, you’ll get an error message.

=IF(VLOOKUP(A6,A2:B7,2,FALSE)=”10”,”YES”,”NO”)
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QUESTION 3:

• Which of these formulas will calculate the total number of letters in 
“Candice Brinkmeyer-Langford”?

A 
=(VLOOKUP("Candice",A2:B7,2,FALSE))+(VLOOKUP("Brinkme
yer-Langford",A2:B7,2,FALSE))

B
=LOOKUP(A3,B2:B7)+LOOKUP(A6,B2:B7)

C 
=(VLOOKUP(A3,A2:B7,2,FALSE))+(VLOOKUP(A6,A2:B7,2,FALS
E))

D 
=VLOOKUP((A3,A2:B7,2,FALSE)+(A6,A2:B7,2,FALSE))
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QUESTION 3:

• Which of these formulas will calculate the total number of letters in 
“Candice Brinkmeyer-Langford”?

A 
=(VLOOKUP("Candice",A2:B7,2,FALSE))+(VLOOKUP("Brinkmeyer
-Langford",A2:B7,2,FALSE))

B
=LOOKUP(A3,B2:B7)+LOOKUP(A6,B2:B7)

C 
=(VLOOKUP(A3,A2:B7,2,FALSE))+(VLOOKUP(A6,A2:B7,2,FALSE))

D
=VLOOKUP((A3,A2:B7,2,FALSE)+(A6,A2:B7,2,FALSE))

=VLOOKUP(lookup_value,table_array,col_index_num,[range_lookup])89



Another example of a nested VLOOKUP

• How can I determine whether Brinkmeyer-Langford is the longest 
name?

• And if it is longest, how much longer is “Brinkmeyer-Langford” than 
the average name?
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Another example of a nested VLOOKUP
• How can I determine whether Brinkmeyer-Langford is the longest name?

• And if it is longest, how much longer is “Brinkmeyer-Langford” than the 
average name?

=IF((VLOOKUP(A6,A2:B7,2,FALSE))=(MAX(B2:B7)),(VLOOKUP(A6,A2:B7,2,FALSE))-
(AVERAGE(B2:B7)),0)

If the value for # of letters in Brinkmeyer-Langford is the same as the maximum value in 
the Num_letters column, then how many more letters does Brinkmeyer-Langford have 
than the average value of the Num_letters column? Or if the # of letters in Brinkmeyer-
Langford is NOT equal to the greatest value for Num_letters, return “0”. 93



Charting data
• A good hypothesis will take you a long way in knowing:

• What to chart

• What type of chart to use

• What data to represent on X and Y axes

• If a secondary axis could be useful for telling the story
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Bar charts

• Start by selecting the data you wish to graph.

• Then, Insert (either Insert menu gets you to Chart)

95



Bar charts

• Excel has multiple options for bar charts.

• Simplest: 2-D Column
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Bar charts

• Customize your look from the menu, 
or…
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Bar charts
• Change colors, font, etc. by selecting the item. 
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Bar charts
• Change colors, font, etc. by selecting the item. 

• Right click to get a menu.

• Choose “Format [whatever]”
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Bar charts
• Change colors, font, etc. by selecting the item. 

• Right click to get a menu.

• Here, I right clicked on one of the bars and chose “Format 
Data Series” to change the bar colors.

• A menu appears to the right.
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Bar charts
• Another option: select the Format menu at the top of the 

spreadsheet window.

• You can also use the Format menu at the top of the Excel window.
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Bar charts
• Add additional items like axes titles, error bars, etc. using Chart Design 

menu at the top.
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Bar charts
• To change font options for any part of the graph, select what you want 

to changes, then use use the Home menu.
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Bar charts
• Here, I have selected one data point (Brinkmeyer-Langford).

• Format Data Point lets me change color, pattern, etc. just for that one bar.

• Add Data Label shows the values for each selected data point (or for everything, 
if you choose).
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Bar charts
• Here, I have selected one 

data point (Brinkmeyer-
Langford).
• Format Data Point lets me 

change color, pattern, etc. 
just for that one bar.

• Add Data Label shows the 
values for each selected 
data point (or for 
everything, if you choose).
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Changing your chart

• Changing your chart 
type entirely:
• Select the whole chart, 

right click, Change 
Chart Type
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Changing your chart

• Changing your chart type 
entirely:
• Select the whole chart, 

right click, Change Chart 
Type

• OR, menu at top of 
spreadsheet:
• Chart Design

• Change Chart Type
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Changing your chart

• Let’s try scatter plotting...
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Changing your chart

• Let’s try scatter plotting...

• Not ideal here.
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Changing your chart

• Bubble scatter plot?!
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Changing your chart

• Bubble scatter plot
• Can vary bubble sizes, 

colors, data labels, etc. as 
before
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Scatterplots

• Simple 
scatterplot to 
compare 
Cat10 values
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Scatterplots

• Format chart as 
before…
• Here, updating 

x-axis bounds.
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Scatterplots

• We can add >1 categories to a 
scatterplot.

• Excel makes them different colors by 
default, but this can be changed using 
the Format menus as before.

• But here, Cat1 and Cat10 are on very 
different scales…
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Adding a secondary axis to show data with 
different scales

• To represent data on separate 
axes (e.g. y- and z-z-axes), we 
start by changing the chart type 
to Combo.
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Adding a secondary axis

• Here is what it looks like at first:
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Adding a secondary axis
• Select one of the two categories.

• Right click – Format Data Series

• Plot series on Secondary Axis
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Adding a secondary axis

• Format further to tell the story effectively.
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Stacked bar charts

• Here, I have calculated the average values for each of the 12 
categories in exposed females and unexposed females. 

Notice where the $ symbols are 
in the formula… 

$ indicates what you do NOT 
want to change when you “drag 
and fill” 

For example: column identity.
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Stacked bar charts: Drag and fill

• ”Drag and fill” 
• Move your mouse cursor over 

lower right corner until it 
becomes “+”,

• Hold down the right mouse 
button 

• drag and fill in the same 
formula for multiple cells  
located immediately below (or 
to the right).
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QUESTION 4

• I used AVERAGEIFS to calculate the Cat1 values, and then 
dragged the “fill handle” (lower right corner) to fill in the 
formula for all the other categories. Which of these 
formulas should I see for the selected cell?

A.=AVERAGEIFS(B4:U4,sample_values!$B2:$U$2,”F”,sample_
values!$B$3:$U$3,”Y”)

B.=AVERAGEIFS(sample_values!B4:U4, 
sample_values!$B2:$U$2,”F”,sample_values!$B$3:$U$3,”Y”)

C.=AVERAGEIFS(sample_values!$B11:$U11,sample_values!$
B$2:$U$2,"F",sample_values!$B$3:$U$3,"Y")

D.=AVERAGEIFS(sample_values!B$11:U$11,sample_values!$
B$2:$U$2,"F",sample_values!$B$3:$U$3,"Y")
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QUESTION 4

• I used AVERAGEIFS to calculate the Cat1 values, and then 
dragged the “fill handle” (lower right corner) to fill in the 
formula for all the other categories. Which of these 
formulas should I see for the selected cell?

A.=AVERAGEIFS(B4:U4,sample_values!$B2:$U$2,”F”,sample_
values!$B$3:$U$3,”Y”)

B.=AVERAGEIFS(sample_values!B4:U4, 
sample_values!$B2:$U$2,”F”,sample_values!$B$3:$U$3,”Y”)

C.=AVERAGEIFS(sample_values!$B11:$U11,sample_values!$
B$2:$U$2,"F",sample_values!$B$3:$U$3,"Y")

D.=AVERAGEIFS(sample_values!B$11:U$11,sample_values!$
B$2:$U$2,"F",sample_values!$B$3:$U$3,"Y")
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Stacked bar charts

• Select data → Insert → 2-D Column → Stacked Column
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Stacked bar charts
• The data does not fit well using the same y-axis.

• Can transform the data in some way, or add a secondary axis for 1 category, 
or…

131



Stacked bar charts

• Much better!

• Next, update the Series 
labels by clicking in the 
Name area…
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Stacked bar charts

• Now we can show how each 
category was affected by 
exposure in females.
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3-D graphs

• Excel offers 3-D options 
for different types of 
charts.

• You can start off with 3-D, 
or you can try it on an 
existing chart
• Select the chart
• Change Chart Type
• Select the 3-D option you 

want
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3-D graphs

• You can change colors, 
fonts, labels, etc. as before.

• Can’t add a secondary axis.

135



Box and whisker plots

• Select the data you want to plot.
• Here, I’ve chosen data that will produce histograms in the same scale range.
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Histograms: Box and Whisker plot

• As before: Insert→ your chart of choice (Box and Whisker plot here).
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Histograms: Box and Whisker plot

• Caution: Nothing is labeled by default.
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Histograms: Box and Whisker plot

• Format→ Shape Outline to show 
individual data points and median line.

• We can change what points are shown 
by right clicking a plot and choosing 
Format Data Series.
• We can only edit one plot at a time.

• Add Legends, Labels, Titles, etc. the 
same way as other charts:
• Chart Design --> Add Chart Element
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Miscellaneous tips and tricks
If I copy these two cells... And try to paste them directly below: 

ERROR!

The “addresses” in the 
formulas of the cells 
update automatically.

Excel will either give an 
error message (if it can’t 
calculate the formula 
because some value is 
missing), or you’ll get a 
bogus result.
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Miscellaneous tips and tricks

Solution: add $ before any part you don’t want to 
change.

Another solution: if you don’t need Excel to 
recalculate anything (for example, you’re just 
copying and pasting some data in another 
place):

Copy the data, then right click where you want 
to paste it, and choose Paste Special → Values
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Miscellaneous tips and tricks
To change the direction of some list: copy the list (NOT cut)…
Then Paste Special --> Transpose
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Miscellaneous tips and tricks
To change the direction of some list: copy the list (NOT cut)…
Then Paste Special --> Transpose
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Miscellaneous tips and tricks…

• Excel can also calculate the minimum, maximum, and average values, 
along with standard deviation, for a data range: =MIN(data_range); 
=MAX(data_range); =AVERAGE(data_range); =STDEV(data_range)
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Next up: Analyzing Big(ish) Data in Excel



Analyzing Big(ish) Data in 
Excel
Dillon Lloyd

North Carolina State University
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Analysis ToolPak Installation

• The Analysis ToolPak is an extension of Excel that can be used to 
perform common statistical tests quickly and easily

• Instructions on installation for both Windows and Mac can be found at 
the link below
• https://support.microsoft.com/en-us/office/load-the-analysis-toolpak-in-excel-

6a63e598-cd6d-42e3-9317-6b40ba1a66b4
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Histogram

• In the Data Ribbon click data analysis 

• Scroll down and click on “Histogram”

• Select the data you want to see the distribution of

• Check “Chart Output” to get a plot in the output

• Click Ok and the histogram will show up in a new sheet

151



Histogram
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T-Test
• Filter Data to the dose row and the row of your gene of interest
• Click Data Analysis on the data tab
• Click T-Test: Paired Two Sample for Means
• Under Variable 1 Range, select the columns in the row of your gene that correspond 

to the control dose
• Under Variable 2 Range, selects the columns in the row of your gene that 

corresponds to the max dose

• Click ok to view the results
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T-Test Control vs. Max Dose T-Test Results
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ANOVA
• Filter Data to the dose row and the row of your gene of interest
• Copy and Transpose Data and create columns for each different dose

• ANOVA requires a bit more data manipulation due to the number of groups 
• Transpose data by highlighting the Dose and Gene of Interest Row, pressing ctrl + shift + right 

arrow key, and copying that highlighted data
• Then go to Home → Paste → Paste Transpose in a new worksheet

• Click Data Analysis on the data tab
• Click on ANOVA
• Under Input Range, select the dose columns created in the previous step

• Group by columns and click ok to get the ANOVA output
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ANOVA
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ANOVA
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Regression
• Filter the data to dose and gene of interest
• Copy the dose and gene row by highlighting the first two cells and clicking 

ctrl+shift+right arrow
• Create a new worksheet and transpose the data In the data analysis tab select 

regression
• Choose the Y variable as the gene expression value, and the X variable as the dose
• Do this by highlighting the numeric value under the header row and clicking 

ctrl+shift+down arrow to select just the numeric cells

• Click ok to review results 
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Regression
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Scatter Plot
• Select Two Genes of interest and the Dose column through the filtering step and 

transpose them into a new worksheet
• Select the two gene columns 
• Click Insert Scatter 
• The Scatter Plot will then appear
• The add a trend line, right click on a point and click add trend line
• The trend line can then be edited to make it more clear 
• These steps can be repeated to make a scatter plot of Dose vs. Gene Expression to 

visualize the regression analysis 
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Scatter Plot
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Boxplot
• Filter to Dose column or row and gene of interest
• Highlight gene column
• Click Insert → Statistics Chart → Box and Whisker Plot
• Right click and select Select Data
• Under series, click edit and select the data at Dose 1, then do the same for Dose 2, 

Dose 3 etc.
• Under Chart Design click Add Chart Element and add a legend to the plot to 

distinguish between doses
• Can then right click on the plot to edit other aesthetic properties
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Boxplot
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Boxplot

164



Boxplot
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R Introduction

• R is a statistical computing language that is very flexible and can do everything we 
have talked about up to this point and more!

• Can create publication ready plots fairly easily
• RStudio is the primer Interactive Development Environment and has a host of 

helpful features that makes coding in R as simple as possible
• Can download R and RStudio from the links below

• R: https://cran.r-project.org/

• RStudio: https://www.rstudio.com/products/rstudio/
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Importing Excel Data into R

• Make sure column names are consistent across files
• Column names should not have special characters or spaces
• Capitalization needs to be consistent, case matters

• Know what kind of file you are reading in
• Are you reading in a csv file? Or a .xlsx file that contains multiple pages?

• Know where your data is located
• What folder? Is it on a google drive or some other network drive?

• Have a plan for your data

• Statistical Tests? Plots? Have a plan before you start
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Importing .csv and .xlsx files into R

• First, locate the file that you want to import on your computer
• Next, open RStudio and click file → New File → R Script
• Then, type the code in the next slide
• Make sure to replace the file path in the green quotations with the location of the 

example file on your computer
• Highlight the code, and press run to have R read in the files

• You can view the files in the viewing pane or by printing the dataset 

• Now, they will be saved into your R workspace and can be used for analysis 
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Importing .csv and .xlsx files into R
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Importing .csv and .xlsx files into R
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Questions??
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Thank you for joining us !

“Manipulating and Displaying 
Big(ish) Data in R”

Fred Wright – North Carolina State University
Burcu Beykal – University of Connecticut

Allison Dickey – North Carolina Sate University

The next session is on October 6, 2021

2:00 – 4:00 pm Eastern US Time


